
 

 

 

 

 

Advanced Techniques in 

Mapping Urban Poverty: 

Analysis of Slums utilizing 

Remote Sensing  
 M.Sc. Geospatial Technologies 

 
 

 
 

 

 
 

 
 

 

 

Muhammad Omar Khan (542576) 
 

 

Institute for Geoinformatics (IFGI) 
Westfälische Wilhelms-Universität Münster (WWU) 

  



Advanced Techniques in Mapping Urban Poverty: Analysis of 

Slums utilizing Remote Sensing 

 
Dissertation supervised by: 

 
Prof. Dr. Torsten Prinz 

Institute for Geoinformatics,  

University of Münster 

Münster, Germany 

 

 

Prof. Dr. Christian Knoth  

Institute for Geoinformatics,  

University of Münster 

Münster, Germany 

 

Prof. Dr. Marco Painho 

NOVA Information Management School (NOVA IMS),  

Universidade NOVA de Lisboa, 

Lisbon, Portugal 

 

 

 

 
 

 

 
September 14, 2024 



i  

Acknowledgement 

I would like to express my sincere gratitude to all those who have supported me in 

making this thesis a reality. First and foremost, I would like to thank my parents 

for their unconditional love and support throughout this journey. 

I would like to thank my supervisors Dr. Torsten Prinz,  Dr. Christian Knoth and 

from the Institute for Geoinformatics, University of Münster, for guiding and 

assisting me with my research in this thesis. Your critique and support have been 

constructive and motivating, and I enjoyed working and learning from you. I would 

also like to thank Dr. Marco Painho from NOVA IMS, Universidade NOVA de 

Lisboa for his on-going support and direction in my work. I would like to also give 

special support to Dr. Christian Kray from Institute for Geoinformatics, University 

of Münster for his support and guidance for my thesis. 

I offer my regards and blessings to all of those who supported me in any respect 

during the completion of the project. Finally, last but not least, I present my sincere 

thanks to my family for their unparalleled love, support, motivation and prayers. 



II  

Abstract 

This thesis aims to explore advanced geospatial techniques for slum identification and 

mapping, focusing on two case studies: Between Nairobi and Rio de Janeiro. Employing 

high resolution satellite imagery and Geographical Information System (GIS) 

technologies, the study adopts the Modified generic slum ontology scale to measure off 

urban poverty. Thus, six parameters were used to compare slum areas with the formal 

settlements, including the slope of the territory, the distance from industrial facilities, 

fractal dimension, roof density, the area of buildings, and the irregularity of roads’ 

networks. The method used in the paper combines the use of Remote Rensing, Generic 

Sum Ontology Framework and Object-Oriented Image Analysis (OOA) to give an 

appreciation of the form of slums. Comparing Nairobi slum and Rio slum, research shows 

that there exist striking variations on topography, city expansion, and structure congestion. 

Slope measurements also suggested that slums in both cities are most likely sited on steep 

and risky slopes, which makes development of infrastructures even more challenging. 

Ideas such as the fractal dimension and road irregularity indicated the clustered nature of 

slum formation. The study concludes with a step forward in this field and substative 

discussion to assist the urban planners to use these spatial findings while implementing the 

slum upgrading interventions towards the realization of the sustainable development goal 

11. 1. 
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1. Introduction 

1.1. Motivation 

Over Urbanization is one of the most significant trends of the twenty-first century. Currently, 

55% of the world’s population is living in urban areas and the projection for the year 2050 is 68 

percent (UN 2018). This paper aims at discussing the effect of urbanization as a social process 

that is regarded as the driving force of economic development resulting in the enhancement of 

living standards, yet bearing social shifts, mostly in the developing world. One of the 

challenges which are evident is the problem of increase in slum areas which are real signs of 

poverty in the urban areas. According to the United Nations, slums lack fundamental amenities 

in the house and the surrounding environment including potable water and sanitation, as well as 

security of tenure (UN-Habitat, 2020). These settlements are usually highly populated with 

dwellers struggling to adequate living spaces thereby raising their risk points on different socio-

economic as well as health parameters. 

The factors that foster the growth of slums are among the following the high rate of migration 

from rural areas to urban areas in the hope of looking for better-paying jobs. But this has led to 

a problem for these growing cities where their infrastructures cannot expand to accommodate 

these people or provide the necessary services which leads to squatter areas. Thus, this scenario 

poses a major challenge to the attainment of SDG 11 that focuses on fostering sustainable 

urban development which is inclusive and safe (UN, 2015). Specifically, SDG 11. The first one 

seeks to ensure access to adequate, safe and affordable housing, as well as slum upgrading by 

the year 2030. To meet this goal, therefore, there is need for timely, precise, usable and efficient 

means of identifying and tracking slum areas. 

Previous methods of mapping the slum areas that involve census data, maps that have been 

drawn in collaboration with inhabitants of the slum areas, and the use of advanced satellite 

image interpretation have been deemed insufficient. These methods do not have the precision 
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and admittance needed to respond to the diverse and dynamic character of slum settings (Kohli 

et al. , 2012). However, they are often flexible by nature and may be hampered by the costs and 

time required to perform them, and thus are not always feasible in many such instances, 

especially in the developing world. Therefore, there is an urgent call for new solutions that 

would help to get over these shortcomings and offer proper information to the legislators and 

urban designers. 

The emerging technologies such as Geographic Information Systems (GIS), and remote sensing 

these days provides very viable solutions to these issues. Also, it combines Object Based Image 

Analysis (OBIA) with the pixel based methods which help in capturing both the spatial and 

spectral properties of slums to have a better perception about such urban environments 

(Hofmann et al ., 2008). 

This research is as a result catalyzed by the necessity of using these advancements in technology 

to come up with a solution that is sound, expandable, and universal in addressing the issue of 

poverty through mapping of slums. This study therefore seeks to contribute to the ongoing 

efforts of enhancing living standards in the slum regions through harnessing the interdisciplinary 

potential of the three approaches of using GIS and remote sensing data towards meeting global 

urban development goals. The findings of this research may be useful to stakeholders concerned 

with urban planning, policy making and development; thus, assisting in the development of 

urban environments that are more equitable and sustainable. 
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1.2. Study Area 

 The study area encompasses two major urban centers: Brazil’s Rio de Janeiro and Kenya’s Nairobi are 

some of the cities which host an international film festival. Both the cities represent the phenomenon of 

Urbanization and the consequent generation of urban poor or the slums as they are called. In Rio de 

Janeiro GPS, favelas are mostly sited in the northern and western parts of the city occupying slopes and 

other inconvenient terrains which are not feasible for construction of proper structures. These areas 

present minimal orderly human settlement patterns, weak infrastructural developments, and subject to 

Strenuous Socio-economic hurdles.  

  

Figure 1:  Aerial View Satellite images of Nairobi & Rio 

However, the situation in the capital city of Kenya, Nairobi, has been different as it has since 

experienced growth of slums especially in the eastern and southern regions of the city. They are areas 

with high population density and grossly lacking in essential infrastructure like water and sanitization 

and electricity and they have a very high poverty rate for their inhabitants. The differences in physical 

and socio-economic nature and structure of slums in Rio de Janeiro and Nairobi, make them useful 

cases for understanding the nature of urban poverty through advanced remote sensing technologies. 

The choice of these cities enables the comparative analysis on how the findings of this study may apply 

globally and how remote sensing can perform in varied urban settings (UN-Habitat, 2020) . 
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1.3. Data 

These sources of data to be utilized in this study comprise diverse spatial datasets required for mapping 

and analyzing poverty in urban areas of the selected study areas. For Rio de Janeiro as well as Nairobi, 

Satellite data with the sensor Sentinel-2 were selected with a spatial resolution of 10m. These images 

were Level-2A (Bottom of Atmosphere) reflectance in order to be useful for the spatial analysis. In 

addition to the satellite images, SRTM DEM with 30 meters resolution was used to derive topographical 

information such as slopes which are vital for the identification of slum settlement. Further, the base 

vector datasets like the building footprint, the road network, and land use data were imported from 

OpenStreetMap and carefully preprocessed with an aim at fixing geometrical issues. These datasets were 

used to compute the GSO indicators when coming up with the physical structure of the slum in both 

cities. Each and all data set used was then transformed to its respective coordinate system that have each 

place in Nairobi being brought under WGS 84/UTM Zone 37S, while Rio de Janeiro was brought under 

WGS 84/UTM Zone 23S (OpenStreetMap, 2023) . 

2. Scope and Objective 

This thesis examines the application of remote sensing and GIS technologies in mapping 

urban poverty and more specifically analysis of slums. It explores the integration of the 

Generic Slum Ontology (GSO) with free and easily accessible earth observation data 

improving the precision and expandability of slum identification. The study calls for the use 

of both pixel level and object level analysis so as to capture the varying attributes of slums 

at different spatial scales. As a result of these analysis, the current study will propose a strong 

research approach that can be utilized across the globe to assist in meeting SDG 11. 1, aimed 

at approaching cities to be more than merely effective places that are safe, resilient and 

sustainable. This work encompasses the identification and categorization of various 

parameters that define slums from the planned communities with an emphasis on a 

comparative assessment of slum regions in Rio de Janeiro, Brazil and Nairobi, Kenya. 
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2.1. Objectives 

• Develop an advanced methodology to map urban poverty using earth observation data. 

• Integrate the Generic Slum Ontology (GSO) with remote sensing and GIS technologies. 

• Analyze and validate key indicators that differentiate slums from planned settlements. 

• Conduct a comparative analysis of slum characteristics in Rio de Janeiro and Nairobi. 

• Assess the scalability and global applicability of the developed methodology. 

 

2.2. Research Questions 

1. How accurately can GSO indicators measurable with freely available data differentiate 

between slums and planned settlements? 

2. How do these indicators vary between slum areas in different countries, specifically comparing 

cities in South America and Africa? 

3. Can the identified GSO indicators establish a two-way relationship between their presence and 

the identification of slum areas, contributing to global efforts in urban poverty mapping?



 

3. Related work (Literature Review) 

3.1. Ontology 

In this case, Ontology, borrowed from Aristotle in the domain of philosophy is a 

concept that relates to the study of being or existence. Ontology in the context of 

slum mapping is crucial for developing a structured understanding of slum 

characteristics. Originally a philosophical concept, ontology in information science 

refers to a formalized system of knowledge for specific domains (Gruber, 1993). In 

remote sensing, it plays a pivotal role in systematically interpreting high-resolution 

satellite imagery to identify slums.  

Structured Knowledge: Ontology organizes domain-specific data for precise slum 

identification. 

Three-Level Categorization: Environs, Settlement, Object – each level aids in 

slum detection. 

Advanced Detection: Combines VHR imagery with expert knowledge for accurate 

slum mapping. 

Improved Scalability: GSO adapts to different regions, enhancing slum 

identification across scales 

 

Figure 2The six general indicators categorized to form a hierarchy to represent concepts at three 

spatial levels. 

 

Generic Slum Ontology (GSO) is grounded in UN-Habitat’s "durable housing" 



 

indicator and categorizes slums into three spatial levels: environs, settlement, and 

object, aiding in precise slum detection (Hofmann et al., 2008). VHR imagery 

combined with expert knowledge enhances the GSO's accuracy, enabling slum 

identification across different regions.  

 
Figure 3 Diagram showing possible site conditions of a slum derived from expert survey. 

The GSO framework supports scalable, regionally adaptable approaches, improving 

urban policymaking and interventions by providing a formal method to analyze 

slum morphology (Ebert et al., 2009). This structured approach is instrumental in 

meeting global urban development goals. 

3.2.  Previous Work on Slum Identification and Mapping 

The identification and mapping of slums are one of the key areas for several 

methodologies in recent past. These methodologies can broadly be categorized into 

three approaches: Census based participatory and by remote sensing method. 

Census-Based Approach 

In census-based approach the data used is derived from national census surveys 

which provide information about the social civil, economic and infrastructural floor 

space of households. Census-based methodologies leverage national surveys to 

provide socio-economic and infrastructural data, spatially disaggregated to various 

levels (Baud et al., 2008). These datasets are useful for mapping poverty and slum 

areas, particularly in the developed world where spatial information on informal 



 

settlements may not be readily available (Baud et al., 2009). However, limitations 

include outdated data due to infrequent surveys and challenges with data 

aggregation across wards of different sizes. 

Participatory Approach 

The participatory approach mainly entails the use of representatives from the slum 

itself whereby the people take an active role in mapping. Participatory mapping 

generally uses questionnaires, focus group discussions and other methods with the 

aim of getting both spatial and non-spatial information on slum regions. This 

method engages local communities to map informal settlements by utilizing local 

knowledge, often through questionnaires and focus groups. This generates highly 

specific data for urban planning (Hasan, 2006; Karanja, 2010). The participatory 

approach is, however, time-consuming and expensive, making it difficult to scale 

in larger urban areas. 

Remote Sensing-Based Approach 

The task of slum identification and mapping has been found to benefit from the use 

of the remote sensing (RS)-based approach. Remote sensing is a multidisciplinary 

scientific method of acquiring spatial data on environment / urban areas from 

satellite and aerial photographs. Remote sensing offers advantages in capturing 

large areas quickly, allowing frequent updates. Techniques have evolved from 

visual interpretation to Object-Oriented Image Analysis (OOA), which is more 

efficient in detecting slum morphology using high-resolution imagery (Mason & 

Fraser, 1998; Hofmann et al., 2008). OOA provides more precise slum mapping by 

analyzing objects (e.g., buildings) and their spatial relationships, although 

challenges remain with image quality and heterogeneity of slum geography. 

Object-Oriented Image Analysis Methods for Slum Identification 

Object-Oriented Image Analysis (OOA) enhances traditional pixel-based methods 



 

by focusing on collections of pixels, or objects, like buildings and streets. This 

approach enables more accurate slum identification by analyzing objects' spectral, 

spatial, and textural characteristics. OOA also considers the interaction between 

neighboring objects, providing a contextual analysis that improves precision in 

urban environments. Hofmann et al. (2008) and Kuffer et al. (2014) demonstrated 

OOA's success in slum delineation using VHR satellite imagery. Despite its 

effectiveness, OOA faces challenges such as fine-tuning segmentation parameters 

and designing classification rules. To address these issues, advanced machine 

learning techniques like support vector machines (SVM) and random forests have 

been integrated into OOA frameworks, improving accuracy. When applied 

correctly, OOA offers a rich, context-aware understanding of urban spaces, 

facilitating more effective slum identification and urban planning. 

Uncertainty Analysis for Image Interpretations of Urban Slums 

Uncertainty analysis is critical in remote sensing, especially when interpreting high-

resolution imagery of urban slums. Factors such as human perception, diverse slum 

characteristics, and architectural density contribute to ambiguities in identifying 

slum areas. Errors can arise in the interpretation of densely populated regions, like 

Kibera slums, due to variations in imagery quality and urban complexity. This 

analysis uses quantitative measurements and probabilities to address potential errors 

in slum identification, ensuring accurate urban planning decisions. Understanding 

these uncertainties is essential for developing reliable methodologies that minimize 

misclassification and improve the accuracy of slum detection in policy and urban 

development frameworks. 

Sources of Uncertainty 

Several factors contribute to uncertainty in image interpretation for slum 

identification: 



 

1. Image Resolution and Quality: The coverage and the resolution of satellite 

pictures assume critical importance as regards the identification of slums. However, 

higher resolution photos provide finer detail about the images and this brings 

problems of volume of data and processing. However, high resolution pictures 

could produce over-simplified images of the urban area, and this leads to the wrong 

classification of slum areas. Further, factors such as temporal fluctuations, noise 

from the sensors, and other atmospheric helps also blur the images and introduce 

noise to the analysis. 

2. Variability in Slum Characteristics: Slums are not homogeneous in general, and 

there are drastic variations with regard to infrastructural facilities, population 

densities, types of materials used, and spatial organization in slum areas within or 

between different zones of vulnerability. Such variations cause some troubles in 

defining which places can be considered as slumps and creating unified protocols, 

which further raises the rates of misunderstandings. It becomes very hard to exercise 

uniformity of classification approach; for instance, one may have highly populated 

slum in a given city while another in another city may have different spectral and 

morphological characteristics despite high population density. 

3. Subjectivity in Interpretation: Human Interpretation of imagery information is a 

process that is subjective in nature that depends on the analyst’s experience, 

knowledge and preconceptions. This opens up the method to subjectivity that results 

in inconsistencies in the identification and classification of slum areas especially 

when different analysts are engaged to undertake the assessment. This subjectivity, 

however, can still be minimized through the use of automated classification 

methods using OOA as only these procedures are still dependent on human input in 

the form of initial classification set and validation set. 

4. Temporal Changes: Slums in urban areas are fluid and respond to different forces 

majoring on growth in population density, migration, and different political actions. 



 

The temporal aspect poses a problem when using imagery from a different period 

as the conditions that can be observed in imagery may not be relevant for the state 

of the slum areas in the present days. This is especially the case with old images or 

when otherwise there is delay in capturing the image and analyzing it. 

3.3. Approaches to Managing Uncertainty 

Addressing uncertainty in slum identification involves combination of 

methodological approaches and validation strategies: 

1. Multi-Temporal Analysis: For this purpose, it is possible to use multi-temporal 

analysis in order to explain temporal changes and reduce certain levels of 

uncertainty. Community monitoring – this involves the use of several images taken 

at different time intervals in order to review the changes of the slum areas. The 

analysis based on trends allows eliminating some uncertainty by revealing whether 

slum areas are growing or shrinking or are under some other type of change. 

2. Ensemble Classification Techniques: Another approach is the ensemble method, 

herein integration of various classification algorithms, which, if applied to slum 

identification, reduces the impact of volatile output of a particular algorithm. If we 

use many classifiers, it is possible to combine their results using such approaches 

as majority voting, weighted averaging, or stacking to enhance the accuracy of slum 

area identification. 

3. Validation with Ground Truth Data: Image based identification of slums requires 

ground truth data which involves either field survey or participatory mapping in the 

process. The errors are quantified and enumerated with results that are yielded by 

the satellite-derived classifications compared with the actual ground observations. 

This validation process assists greatly in the fine-tuning of the classification models 

so as to enhance sufficient accuracy levels. 

4. Uncertainty Quantification Techniques: Three different statistical techniques 



 

which can be used to estimate the level of variability in slum identification are 

Review of Literature and GIS. For example, confidence intervals, error matrices, 

all kinds of probability structures can be employed in order to estimate the 

probability of classification and in order to find out where the model fails. These 

techniques give the useful information regarding the reliability of the classification 

results for supporting decision making in the urban planning and policy. 

An example of sensitivity analysis includes the periodic 

Sensitivity Analysis: Sensitivity analysis involves systematically varying the 

input parameters of the classification models to assess their impact on the results. 

An example of sensitivity analysis includes the periodic adjustment of the input 

parameter s of the classification models in order to evaluate the effects of such 

changes on the outcome. These allow in determining which causes contribute 

much to uncertainty and the consequent fine-tuning of the model parameters to 

reduce these impacts. Sensitivity analysis is very effective in object-oriented 

image analysis for the segmentation parameters that can affect the identification of 

slum areas to a large extent. 

3.4. Case Studies of Uncertainty Analysis in Slum Mapping 

Regarding the measurement of slums, the methods used have also assessed the 

uncertainty analysis in studies several research. For example, Kuffer et al. ,(2016), 

made an uncertainty assessment of slum mapping in Nairobi Kenya with VHR 

imagery available. To reduce uncertainty in the study, the research used multi-

temporal analysis and more so ensemble classification techniques. Kohli et al. 

(2012) performed research on slum mapping using uncertainty quantification 

approach wherein, the credibility of slum mapping for different benchmarks of 

India was estimated and it revealed the need for ground truthing for minimizing 

classification variability.  



 

 

 
Figure 4 Final classified map of the study area with slums, ground pictures and corresponding zoomed views 

of image: 
(a) Ground photograph of buildings in Old City. (b) Ground photograph of a typical slum settlement; (c) Magnified view of 
a part of Old city misclassified as slum on final map; (d) A typical slum settlement. 

It includes identification of the different sources of uncertainty, powering 

techniques for uncertainty control and reduction, and checking of such results with 

ground truth information. Geographical systematically dealing with uncertainty, 

geographical researchers improve the reliability of the slum mapping studies and, 

consequently, increase the chance of making better decisions in these areas of urban 

growth and poverty reduction. 

  



 

4. Methodology 

The methodology section outlines the systematic approach undertaken in this research 

to identify and analyze the physical characteristics of slum areas in two cities, Rio de 

Janeiro (Brazil) and Nairobi (Kenya). This research relies on advanced satellite image 

data and other GIS data to analyze the relative merits of Generic Slum Ontology (GSO) 

indicators. The workflow is divided into three main objectives: identification of the 

types of data required, data collection and data cleaning process, computation of the 

GSO indicators and lastly comparison of the characteristics of the slum across the cities. 

 

 

Figure 5 Pictorial Form of Methodology Overview  

 



 

 

 

Figure 6 Flow Chart view of Methodology 

  



 

 

4.1. Workflow Overview 

The research methodology is structured into three primary phases: 

1. Data Collection and Pre-Processing: In this phase, the required satellite imagery, 

DEMs will be procured and OSM observational data will also be collected. The data is 

then preprocessed so as to ensure that it is in the right format and resolution for further 

assessment. 

2. Identification and Calculation of GSO Indicators: In this phase, specific indices 

which characterize a slum are defined and computed. These indicators are drawn 

established by direct measurement based on vector data and by indirect measurement 

by means of remote sensing data surrogates. 

3. Comparative Analysis: The last stage includes the comparison of calculated indices 

in the framework of particular cities and the comparison of the two compared cities. 

The rationale for this step is to analyze the differences in the slum characteristics at 

different spatial scales and assess the generality of the identified indicators. 

The details of each of the steps incorporated in the methodology are discussed below. 

4.2. Data Collection and Pre-Processing 

Study Area Selection 

The study focuses on two cities with significant slum populations: Brazil and Kenya; 

two cities, Rio de Janeiro (rectangle coordinates (lng,lat): -43.273,-22.947 x -43.134,-22.866) 

and Nairobi (GPS rectangle coordinates (lng,lat): 36.744,-1.331 x 36.913,-1.225)  

respectively. These cities were chosen because of their different geographical, social 

and economic environments in order to compare properties of slums in different urban 

settings. 



 

Satellite Imagery Acquisition 

The primary data in this study embraced Sentinel-2 satellite imagery in a 10 m spatial 

resolution collected in the year 2017 in accordance with literature. This is the reason 

why Sentinel-2 was selected with a high spatial resolution that can help in the 

identification of fine features within urban areas. The images were obtained from Level 

2A archive which contains images containing BOA reflectance. 

Digital Elevation Model (DEM) Acquisition 

Among the data sets that have been employed in this study is the Shuttle Radar 

Topography Mission (SRTM) DEM which yields elevation data at a thirty-meter raster 

resolution. The DEM was relevant for determining the other topographical attributes of 

the slum zones including slopes which are key aspects of slum formation and spread. 

OpenStreetMap (OSM) Data 

Recent geographic data was also acquired from OSM for the two study areas 

comprising of vector data comprising of roads, buildings, land use and other places of 

interest. But this data contained geometrical errors hence needed so much cleaning and 

correction to yield the results displayed above. Consequently, all the layers that were 

prepared for Nairobi were reprojected with WGS 84/UTM Zone 37S while those for 

Rio de Janeiro were reprojected with the same WGS 84/UTM Zone 23S. 

4.3. Data Pre-Processing 

Data preprocessing involved several critical steps: 

1. DEM Gap-Filling and Reprojection: However, problems such as sinks or gaps in the 

SRTM DEM were also evident, particularly where there was dense vegetation or water 

cover. Ablations of gaps were performed using interpolation techniques in order to 

obtain a smooth surface in analysis of slope. The DEM was also transformed to the 

right spatial reference system (SRS) of the cities in question. 



 

2. OSM Data Cleaning: The OSM data was checked for topological inconsistencies and 

entities like Place, Addr: addr and Railway were simply checked for topological errors 

like overlapping of features, alignments and merged features were separated. This step 

was important to minimize the errors in vector-based calculations for the GSO 

indicators. 

3. Reprojection and Resampling: Each of these datasets was then reprojected into a 

common CRS and resampled to concur with the spatial resolution of the Sentinel-2 

imagery acquired during the analysis. This step makes it possible to ensure all datasets 

have the same spatial references to allow for accurate overlay and analysis. 

4.4. Identification and Calculation of GSO Indicators 

The methodology's second stage is devoted to determining and computing certain 

indicators from the GSO framework. The physical characteristics of slums are 

described by these markers at different geographical dimensions, from single structures 

to entire neighborhoods. 

 

GSO Indicators Selection 

The Generic Slum Ontology framework categorizes slum characteristics into three 

spatial scales: environs, settlement, and object level. This study focuses on six primary 

indicators: three that can be directly calculated from vector data (shape, building size, 

and access network) and three that require the use of physical proxies derived from 

remote sensing imagery (slope, proximity to industries, and green roof coverage). 

These indicators were selected based on their relevance to slum morphology and the 

availability of data for their calculation. 



 

 

Table 1 GSO Characteristics with relevant Spatial Levels 

4.5. Physical Characteristics and Proxies 

The selected indicators and their corresponding physical characteristics or proxies are 

outlined below: 

1. Slope (Environs Level): Slope is a critical factor in slum formation, as slums are often 

located on steep terrains that are unsuitable for formal development. The slope was 

calculated from the SRTM DEM using the Zonal Statistics tool in QGIS, providing the 

minimum, mean, and maximum slope values for each slum area. 

2. Proximity to Industries and Socio-Economic Activities (Neighborhood Level): 

Slums are typically located near areas of high socio-economic activity, such as 

industries or central business districts (CBDs), where employment opportunities are 

more abundant. Proximities were calculated by creating a 500-meter buffer around 

slum areas and analyzing the land-use composition within this buffer using OSM data. 

3. Shape (Settlement Level): The shape of slum areas often reflects the constraints 

imposed by surrounding linear features, such as roads, railways, or rivers. Fractal 

Dimension was used as a measure of shape complexity, calculated by rasterizing slum 

polygons at varying cell sizes and applying the box-counting method. This method 

assesses the relationship between the box size and the count needed to cover the slum 

area, with higher fractal dimensions indicating more complex shapes. 

4. Roof Coverage (Settlement Level): Roof coverage serves as a proxy for population 



 

density and the degree of open space within slum areas. Roof coverage was calculated 

as the ratio of the area of green roof slum footprints to the total area of pixels within the 

slum boundaries with NDVI as base layer. Sentinel-2 imagery was classified using 

NDVI threshold to differentiate between built-up and non-built-up areas, facilitating 

the calculation of roof coverage. 

5. Building Size (Object Level): Slum areas are characterized by small, densely packed 

buildings. The area of building footprints was calculated using OSM data, providing an 

estimate of building size. This indicator helps differentiate between slum and non-slum 

areas based on the typical size of buildings. 

6. Road Network Irregularity (Object Level): The irregularity of road networks within 

slum areas was quantified by calculating the number of nodes per kilometer of roads 

within the slum boundaries. This indicator was derived from OSM road network data 

and reflects the often chaotic and unplanned nature of slum infrastructure. 

4.6. Geospatial Processes for Indicator Calculation 

The following geospatial processes were applied with detailed screenshots (hence no 

mention of figure numbers on these) from the QGIS software interface have been added 

to highlight the detailed steps undertaken to calculate the above indicators: 

• Slope Calculation: The calculation of the slope is pivotal in establishing the spatial 

dynamics of the spread of slum, more so in regions with differentiated topography, for 

instance Nairobi and Rio de Janeiro. This is so because slope is very influential in the 

general growth and development of the urban areas; areas with high slopes are 

considered undesirable for planned settlements hence are characterized by the informal 

structure. In this study, SRTM DEM data was imported into Q-GIS for both the cities 

and for data analysis, two main variables were incorporated into this study which 

include the following: The DEM derived from the raster data having a resolution of 30 

meters was used to compute slope. For this purpose, the QGIS contains the built-in tool 



 

called Slope which can be accessed in Raster > Analysis > Slope which calculates the 

slope degree for each pixel. This process created the slope raster presenting the 

gradients within the city, thus indicating areas of largely elevated steepness. Symbology 

was used in slope raster to differentiate between low, medium and high slopes with a 

sharp focus on steep slopes represented in red. So as to assess slum areas with regards 

to slope, the boundary shapefiles of the slum study areas were superimposed on the 

slope layer. The mean slope for slum and residential area was calculated using the Zonal 

Statistics tool of the QGIS software which would help in comparing both the scenarios. 

The findings provided knowledge regarding the influence of slope to slum growth, 

where slums are usually built on hazard prone steep slopes, which make it difficult to 

establish infrastructures and environment people live. 

➢ Fill No-Data: Use QGIS's built-in Slope tool. For that firstly the DEM has to be pre- 

processed to have no gaps and empty data.  

  



 

 

➢ Slope Analysis Tool: Navigate to Raster > Analysis > Slope, selecting the DEM as the 

input layer. This will compute the slope for each pixel. 

 

➢ Symbology Setup: Apply color symbology to distinguish between slope levels. 

Steeper areas can be marked in red to visualize risks of landslides, especially in slum 

areas. 



 

 

➢ Segregating Residential vs. Slum Areas: Overlay the slum boundary and residential 

shapefiles with different boundary color to differentiate and calculate the mean slope 

within slum vs. residential areas for comparison. 

 

• Proximity/Buffer Analysis: The proximity analysis  is done to determine how close 

the slum areas are to socio-economic activities like industries; trade areas and other 

important land-use types. This facilitates in identifying the economic potential and 

environment/the ecological hazards provided in the area/and known as slums. The first 



 

step involved filtering land-use data in QGIS to isolate five specific classes: many 

buildings and structures including allotments, commercial areas, construction sites, 

farmland, and industries. This was done by putting attribute filters on the land-use 

vector data. After the classes were chosen, a 500-meter buffer was created around the 

limit of the slum areas with the help of the Buffer function in QGIS. This gave the basic 

way of evaluating the distance of the slums by establishing a buffer zone around them. 

With the help of the Overlay and Clip tools, the buffer was overlay on the land-use 

features to determine which socio-economic activities were located in the buffer area. 

After overlaying, the Basic Statistics tool was applied to find out the percentage of the 

slum areas that fall in the buffer zones. This assisted in establishing the measure to 

which the slum populace is accessible to economic activities on foot. The findings by 

this study revealed that the slums in Nairobi are relatively closer to economic centers 

compared to the slums in Rio de Janeiro which gave a socio-economic background to 

inhabitants of the slums in each city 

➢ Filtering Land-Use Classes: Filter land-use data for the five categories: allotments, 

commercial areas, construction sites, farmland, and industries. 

 

➢ Overlay and Clip Analysis: Use the Clip tool to extract the land-use features within 

the slum boundaries and buffer zone. This identifies the proximity of slums to economic 

activities. 



 

 

 

➢ Buffer Tool: Apply a 500m buffer to slum boundary shapefiles by using the Vector > 

Geoprocessing Tools > Buffer option in QGIS. 



 

 

➢ Calculating Percentage Overlap: Apply the Basic Statistics tool to determine the 

percentage of slum areas overlapping with the buffer zones, offering insights into socio-

economic proximity. 

 

• Fractal Dimension Calculation: Slum polygons were rasterized and converted to line 

string in the first place and then the minkowski DimCalculator-2.0 was used to 



 

calculate mink dimension which further help in determining the fractal dimension being 

helpful in managing complexity of the shape of slum. Fractal dimension is a 

mathematical concept which describes the degree of detail and self-similarity of the 

geometrical or real structures, and which can be helpful to explain the irrational and 

random construction of slums. The plugin used in calculating fractal dimensions was 

Minkowski Dimension for which the deviation of slum areas from the standard 

Euclidean geometry, where simple geometrical shapes such as squares and rectangles 

have comparatively low fractal dimensions. First, the slum and the residential polygons 

were transformed to the LineString format using Vector > Geometry Tools > Polygons 

to Lines on QGIS. This made it possible to identify the building line within the slum 

areas. Subsequently, the slum polygons were buffered with building footprints to 

extract structures within the slum as well as the neighboring residential region. The 

Minkowski Dimension tool was used in both datasets whereby the mean fractal 

dimension for each area was computed. On an overall note, the mean fractal dimension 

was lower for the slum areas which means that they are more complex in nature and 

there are many gaps and crannies in the structures as compared to the identified regular 

areas as compared to planned areas having value closer to 1 indicating a stability in 

geometry. They created the added benefit of offering a quantitative means of comparing 

slum complexity within and between cities. For instance, by comparing the two cities, 

higher fractal dimensions were apparent in Nairobi with the slum areas experiencing 

more decentralization and higher extent of urban sprawl than the slums of Rio de 

Janeiro. 

➢ Clip Analysis: Use the Clip tool to extract the land-use features within the slum 

boundaries and residential areas were clipped with building footprints to isolate 

structures within slum and residential areas 



 

 

➢ Converting to LineString: Convert slum and residential polygons into LineString 

format using the Vector > Geometry Tools > Polygons to Lines. 

 

➢ Minkowski Dimension Calculation: Run the Minkowski Dimension tool to compute 

fractal dimensions for both slum and residential areas in Nairobi and Rio. This reveals 

the complexity and disorganization typical of slum layouts compared to planned areas. 



 

 

 

• Green Roof Coverage Estimation: Green roof coverage is another way used to 

determine the vegetation density in the urban environment, especially in the distinction 

between spaces without essentially any vegetation and those that do have vegetation. 

For landscape heterogeneity examination, the Normalized Difference Vegetation Index 

(NDVI) was employed to measure the vegetation physical density.  



 

Sentinel-2 imagery was loaded into QGIS, and the Raster Calculator was used to 

compute NDVI values with the formula: NDVI = (B8 - B4) / (B8 + B4)  

where B8 is the Near-Infrared (NIR) band, and B4 is the Red band. The resulting NDVI 

layer was then overlaid with slums and residential areas. Using the Zonal Statistics 

tool, the mean NDVI values were calculated for both slum and residential zones. A 

threshold value of NDVI > 0.35 was applied to classify areas with substantial 

vegetation (green roofs). In the Field Calculator, a new field named "Green_Roof" 

was created, assigning a value of 1 to areas with NDVI > 0.35 and 0 to areas with lower 

values. This method enabled separation of vegetated areas from other non-vegetated 

built-up areas based on the Greenness. The final outcomes were displayed in the form 

of symbols to depict the areas of green roofs in slums and residential places. In relation 

to green roofs coverage, it was observed that slum areas were characterized by 

overcrowded environment with congestion resulting to little or no open spaces. 

➢ Zonal Statistics: Apply Zonal Statistics to calculate NDVI for slum and residential 

areas separately.  

 

➢ Setting of Green Roof Threshold: Use a threshold of NDVI > 0.35 to define green 

roofs. Add a new field in the attribute table to classify areas with NDVI > 0.35 as 1 

(green roof) and ≤ 0.35 as 0 (non-green). 



 

 

 

➢ Basic Statistics: Compute the percentage of green roof areas using the Basic Statistics 

tool to show variations in vegetation cover between slum and non-slum areas. 

 

• Building Size Estimation: Building size is the most effective way to measure urban 

compactness and dwellings’ quality, especially the quality of the buildings in slum 

areas where the buildings are small, and the density of the buildings is high.  To estimate 

building sizes, OpenStreetMap (OSM) building footprint data was clipped to isolate 



 

buildings within slum and residential areas using the Clip tool (Vector > 

Geoprocessing Tools > Clip). After the buildings were clipped, a new field named 

"Area" was added in the Field Calculator using the formula $area to compute the area 

of each building polygon. This offered the sizes of the building in terms of the area in 

square meters of the slum and the residential areas. The average building size was then 

determined from the Basic Statistics tool for each area identified. These results agree 

with the overcrowded and enclosed slum settlements with limited available space and 

prevailing nature of informal construction. 

➢ Clipping buildings in Slum Areas: Use the Clip tool to extract building footprints 

within slum and residential areas. 

 

➢ Area Calculation and Basic Statistics: Add a new field in the attribute table using the 

Field Calculator, and compute building areas using the formula. Calculate average 

building size for both slum and residential areas. This reveals smaller, overcrowded 

structures in slums compared to planned areas 



 

 

• Road Network Irregularity Calculation: Road irregularity is an indicator of the 

lack of planning in slum areas, and  telling how unplanned the area is particularly the 

slum area where the roads are characterized by a small, irregular and twisting path. To 

calculate road irregularity, the road network data for slum and residential areas was first 

clipped using the Clip tool. This separated the roads within slum areas from those in 

more structured, planned residential zones. Next, the Extract Vertices tool was used 

to identify the nodes or intersections within the road network. This step was essential 

for measuring road complexity. To provide a more structured analysis, a 1x1 km grid 

was added to the map to calculate node density per kilometer of road. Two node counts 

were calculated: one per road segment and another per grid unit using the Count Points 

in Polygon tool. The same was observed in this study where the node densities tended 

to be higher in the slum areas signifying much disorganized patterns of network and 

fragmentation of roads compared to homogeneity of the neighborhood of the residential 

zones. This metric aids in measuring the number of infrastructural barriers that people 

living in slums suffer from, especially in the areas of service delivery such as response 

to disasters or accessibility of strategic resources such as roads. 

➢ Adding a Grid: Add a 1x1 km grid to the map to calculate node density both per road 



 

segment and per km². This provides a measure of road irregularity, which is generally 

higher in slum areas. 

 

➢ Clipping Roads: Use the Clip tool to separate road networks within slum and 

residential boundaries. 

 

➢ Extract Vertices: Apply the Extract Vertices tool to identify road junctions and 

vertices, which will be used to measure road irregularity. 



 

 

➢ Node Count Tool: Use the Count Points in Polygon tool to calculate the number of 

nodes per road. 

 

➢ kernel vector tool: to count the density in a grid, showing the fragmented 

nature of slum infrastructure. 

 



 

 

The below table summarizes which datasets and geospatial processes were used for the 

calculation of above physical characteristics: 

 

Table 2 Summary Table of datasets and geospatial processes 

4.7. Intracity Slum Comparative Analysis 

Slum areas are highly heterogeneous, even within the same city, due to varying 

environmental, social, and economic conditions. To capture this variability, a 

comparative analysis was conducted to examine the differences in slum characteristics 



 

within each city. 

Approach 

The comparative analysis involved comparing the calculated indicators for different 

slum areas as compared to residential areas within each city. The analysis focused on 

identifying patterns and trends in the physical characteristics of slums, such as 

differences in slope, building size, and roof coverage, which could indicate varying 

levels of development and infrastructure quality. 

Findings 

The findings from the intracity analysis revealed significant variation in slum 

characteristics within both cities. In Nairobi, slums located closer to the city center 

tended to have smaller building sizes and higher roof coverage, indicating higher 

population density and more intense land use. In contrast, slums located on the 

periphery of the city exhibited larger building sizes and lower roof coverage, suggesting 

less dense development. In Rio de Janeiro, slums on steeper slopes had more irregular 

shapes and road networks, reflecting the challenging topography and unplanned nature 

of these settlements. 

4.8. Intercity Slum Comparative Analysis 

The final phase of the methodology involved a comparative analysis of slum 

characteristics between the two cities. This analysis aimed to determine the extent to 

which the identified GSO indicators are applicable across different urban contexts and 

to assess the potential for global application of these indicators. 

Approach 

The intercity comparative analysis involved comparing the calculated indicators for 

slum areas in Rio de Janeiro and Nairobi. The analysis focused on identifying 

similarities and differences in slum characteristics between the two cities and 



 

understanding the factors driving these differences. The analysis also explored the 

thresholds for each indicator, assessing whether these thresholds differed significantly 

between the cities. 

Findings 

The intercity analysis revealed both similarities and differences in slum characteristics 

between Rio de Janeiro and Nairobi. Both cities exhibited slums with high roof 

coverage, small building sizes, and irregular road networks, reflecting the common 

challenges of informal settlements in urban areas. However, significant differences 

were observed in the slope and shape indicators. Slums in Rio de Janeiro were generally 

located on steeper slopes and exhibited more complex shapes, likely due to the city's 

mountainous terrain. In contrast, slums in Nairobi were more likely to be located on 

flatter terrain, with less complex shapes. 

4.9. Data Management Plan 

To ensure the systematic organization and management of the datasets used in this 

research, a comprehensive data management plan was developed. This plan involved 

creating a structured file directory and maintaining detailed metadata for each dataset. 

File Structure 

The top-level directory for the project was named "Project" and was organized into the 

following subdirectories and is to be uploaded via google drive link along with all the 

necessary data related to the project: 

• Sentinel-2 Images: This subdirectory contained the raw and pre-processed Sentinel-2 

images for both cities, with filenames indicating the city, satellite, and processing level 

(e.g., "Nairobi_S2A_L2C_Image.tif"). 

• SRTM DEM: This subdirectory contained the raw and pre-processed DEM files for 

both cities, as well as slope maps generated during the analysis (e.g., "Slope_Rio.tif"). 



 

• OSM Data: This subdirectory contained the OSM vector data for both cities, including 

layers for buildings, roads, places, and land use (e.g., "Buildings_Nairobi.shp"). 

• Slum Boundaries: This subdirectory contained the shapefiles for the slum boundaries 

in each city (e.g., "Slum_Nairobi.shp"). 

• Administrative Boundaries: This subdirectory contained the shapefiles for the 

administrative boundaries in each city (e.g., "Adm_Rio.shp"). 

Metadata 

 A metadata table was created to provide detailed information about each dataset, 

including the data source, year of creation, filenames, and specifications. The metadata 

ensured that all datasets were properly documented, facilitating reproducibility and 

transparency in the research. 

 

Table 3 Summary Metadata table 

The methodology outlined in this section provides a comprehensive framework for 

analyzing the physical characteristics of slum areas using remote sensing and geospatial 

data. The systematic approach to data collection, indicator calculation, and comparative 

Data Process 

step 

Source Filenames Specification 

2 Sentinel-

2 Images 

Pre-

processing 

Open 

source 

{city}_{satellite}_{level}_Image.tif 10m spatial 

resolution and 

13 bands each 

DEM Pre-

processing 

Open 

source 

{city}_DEM.tif 1 Arc 

Second/30m 

Slope Slope 

calculation 

Processing Slope_{city}.tif Slope for each 

pixel in 

percentages 

OSM Used in 

geospatial 

processes 

BB Bikes Places_{city}.shp 

Buildings_{city}.shp 

Roads_{city}.shp 

Landuse_{city}.shp 

Vector data 

representing 

different 

features 

Slum 

Boundary 

Used in 

calculation 

of spatial 

proxies 

Open 

source 

slum_{city}.shp Vector data of 

slum 

boundaries 

Administra-    

tive 

boundaries 

Used in 

calculation 

of spatial 

proxies 

Open 

source 

Adm_{city}.shp Vector data of 

administra-tive 

boundaries 

 



 

analysis ensures that the research findings are robust and applicable across different 

urban contexts. By identifying and quantifying key slum characteristics, this study 

contributes to a better understanding of the spatial dynamics of informal settlements 

and their potential implications for urban planning and policymaking. 

5. Results  

The results presented here provide a comprehensive analysis of the physical 

characteristics of slum areas in Nairobi and Rio de Janeiro. The analysis would 

primarily be drawing on geospatial processes applied to calculate key indicators such 

as slope, proximity to socio-economic activities, fractal dimension, roof coverage, 

and building size. These results are discussed in the context of urban planning. 

Furthermore, these also lay a special emphasis on how these physical characteristics 

influence the living conditions and development potential of slum areas. 

5.1. Slope Calculation 

Nairobi 

In Nairobi, therefore, looking at the slope of areas that are considered slums and 

comparing them with other areas that are considered non-slum we find a difference. 

The mean slope for slum areas was then based determined as 10. 19%, compared to 

6. 39% for non-slum areas. What distinguishes graduate symbol map is the slope of 

the line in planned settlements as conveyed in blue-lined areas and in slum areas 

depicted in black. 

From this it can be deduced that the slum areas usually are situated on the steep slopes 

of the city, and this has several implications for the inhabitants. Slopes were also 

found to be a major threat to the structures due to increased rate of soil erosion and 

landslides during the rainy season which is frequent in Nairobi. The higher slopes in 

slum areas also make it difficult for one to construct a strong and durable structure, 

thus, there is use of temporary or even semi temporary houses which could not so 



 

well resist the stresses of the environment. Further, some of the slopes may act as 

barriers in accessing needs such as water, sanitation and transport, as these regions 

do not have proper infrastructure. 

 

Figure 7 Mean Percentage Slopes for Slum and Non-Slum Areas in Nairobi (QGIS) 

Land Feature Mean Slope  Colour Notation 

Slum Areas 10.19 Black 

Residential (non-slum) 6.39 Blue 

Table 4 Key Statistical metrics extracted for Slum and Non-Slum Areas in Nairobi 

Rio de Janeiro 

In the same way, the slum areas in Rio de Janeiro have steeper slopes with higher 

mean compared to planned settlements. This steepness is illustrated in the 

accompanying map in which the symbology scheme used is similar to that employed 

for Nairobi but with the color of the roads being different. 

This is especially very evident in Rio de Janeiro where steep slopes have been 

experienced mainly due to the rugged terrain. These areas are commonly called 

‘favelas’, and usually, they are situated on steep slopes that also imply the difficulties 



 

of the official construction. The slopes are extremely steep hence increasing the 

danger of landslides, where harms that arise from such disasters have been 

catastrophic to some of the favelas in the past. These physical characteristics also 

affect the land use since people construct their houses wherever they find space, 

which may well be on unstable ground. 

 

Figure 8 Mean Percentage Slopes for Slum and Non-Slum Areas in Rio (QGIS) 

 

Land Feature Mean Slope  Colour Notation 

Slum Areas 13.08 Black 

Residential (non-slum) 6.54 Orange 

Table 5 Key Statistical metrics extracted for Slum and Non-Slum Areas in Rio 

Comparing Nairobi and Rio de Janeiro, it can be seen that slum areas are more likely 

to be located in areas with steeper slopes, which is not a coincidence from socio-

economic point of view. As famously explained, the flat terrain remains preferred for 

the rich or planned developments, while the steep and dangerous slopes are for the 



 

poor or the squatters. Such spatial inequality means that interventions have to be made 

to cater for the high risks involved in slum environments and the people occupying 

them. 

5.2. Proximity to Industries and Socio-Economic Activities 

Nairobi 

Analyzing Nairobi, the proximity of slum areas to industries and other socio-

economic activities was analyzed by examining the distance from slum areas to five 

key classes: residential areas, industries, commercial areas, farmland-devel opioid 

construction sites and institutional areas. The proximity analysis showed us that 83% 

of the slum areas are located within a 500-meter radius of one or more of the socio-

economic activity zones as illustrated in the proximity analysis map above. 

This level of proximity can be construed to mean that slum areas in Nairobi are well 

placed in areas of economic incomes, which can be an advantage/ disadvantage. 

While on the other hand the areas provide the residents with easy access to 

employment, markets, and other essential services that are vital in their daily lives. 

On one hand, living close to industries and construction areas has some 

disadvantages; one can be affected by pollution, noise, and traffic jam. Furthermore, 

competition for space especially around such socio-economic activities means that 

increased population densities are witnessed in slum areas and hence problems such 

as overcrowding and poor physical infrastructure are further prone. 



 

 

Figure 9 Buffer Analysis of Nairobi with 500m proximity for Slum areas as with reference to 

Industries 

Land Feature Overlapped Areas % Buffer Parameters 

Slum Areas 83.5 500m 

Residential (non-slum) 52 500m 

Table 6 Key Statistical metrics extracted for Slum and Non-Slum Areas in Nairobi 

Rio de Janeiro 

In contrast, the analysis for Rio de Janeiro indicated that only 20-30% of slum areas 

are located within 500 meters of the five socio-economic activity zones: - allotments, 

commercials, constructions, farms, industries and many others. With this smaller 

percentage it is therefore safe to infer that slum areas in Rio de Janeiro are relatively 

more pulled back from these zones of economic activity as compared to those in 

Nairobi. 

In view of this, isolation may have various repercussions to the dwellers of the favelas 

in Rio de Janeiro. Lack of employment opportunities and services continue to set up 

a poverty and social exclusion cycle, due to long distances likely to be travelled to 



 

areas of economic activities. This also means that the slum areas are not located close 

to the socio-economic centers which in effect isolates the slum dwellers from the 

mainstream economy of the city. 

 

Figure 10 Buffer Analysis of Rio with 500m proximity for Slum areas as with reference to Industries 

Land Feature Overlapped Areas % Buffer Parameters 

Slum Areas 24.6 500m 

Residential (non-slum) 45.4 500m 

Table 7 Key Statistical metrics extracted for Slum and Non-Slum Areas in Rio 

A comparison between Nairobi Slum and Rio de Janeiro shows that the locations of 

the slum with regard to economic activities differ, resulting from different urban 

planning past and present societal characteristics. While in Nairobi, the-slum areas 

are relatively being incorporated into the mainstream economy with its attendant 

risks, the opposite is the case of Rio de Janeiro hence the need to improve connectivity 

of the-slum areas. 

5.3. Fractal Dimension 



 

The fractal dimension is a measure of the complexity of the shape of slum areas, with 

higher values indicating more irregular and complex shapes. Mean fractal dimension 

that was found in the slum areas of Nairobi was estimated to be between 0.5 and 0.6; 

This is a very less score, showing a lack of richness in the shape geometry and 

meaning very complex and irregular shapes.  

 

Figure 11 Building Fractal dimensions for Slum and Non-Slum Areas in Nairobi (QGIS) 

Land Feature Mean mink dimension  Colour Notation 

Slum Areas 0.56 Yellow 

Residential (non-slum) 0.78 Orange 

Table 8 Key Statistical metrics extracted for Slum and Non-Slum Areas in Nairobi 

This is due to the fact that slums in Nairobi have developed haphazardly due to the 

lack of systematic planning and development and people construct a house for a 

variety of reasons without much concern to how the other people will lay out their 

homes.  



 

 

Figure 12 Building Fractal dimensions for Slum and Non-Slum Areas in Rio (QGIS) 

Land Feature Mean mink dimension  Colour Notation 

Slum Areas 0.67 Yellow 

Residential (non-slum) 0.89 Green 

Table 9 Key Statistical metrics extracted for Slum and Non-Slum Areas in Rio 

The overall mean F was observed to be of the order of 1 for the slum regions in the 

city of Rio de Janeiro between 0.5-0.7 , which while still showing some extent of a 

shift from basic and simplistic geometrical forms is slightly lower than that of 

Nairobi.  

This means that while the slum formation in Rio de Janeiro is also irregular as in 

Nairobi it may be less complex implying that it has at least a slightly more order 

structure.  

This difference may be attributed to various factors such as the history of the favelas 

in Rio de Janeiro is relatively older as compared to the favelas in other cities, hence 

there could have been possibility for some form of order to have evolved overtime. 

The higher fractal dimension could also be attributed to the growth of population in 

Nairobi as well as the resultant pressure towards enhancement of shelter 

development. Slums are areas that are occupied by new migrants on arrival in the 

city, and because they are not in a systematic order , they expand the size of the slum 

in a haphazard manner. This results in very complex shapes of the slum structures in 



 

Nairobi due to the fact that new structures are built in a haphazard manner as and 

when space is available. Rio de Janeiro favelas exhibited slightly lower fractal 

dimension, which may be related to the fact that they are more mature settlements in 

which people have longer time to arrange their territory. Though, as earlier mentioned 

when describing Rio de Janeiro’s favelas, the existence of steep slopes may serve to 

increase the general level of irregularity in these regions since people have to 

construct their houses according to these realities. 

5.4. Green Roof Coverage 

Green Roof coverage is one of the best ways of determining the amount of 

concentration in slum areas and the degree of development fitting the area. In Nairobi, 

roof cover was estimated using NDVI data where it was possible to distinguish 

between vegetation and non-vegetation. The factor analysis showed that there could 

be a significant variation in terms of roof coverage percentage in the slum areas 

minimum 2. It ranges from 7% to a maximum of 53%. This implies that there are 

relatively large disparities in the extent to which roof coverage has prevented slums 

areas from extending across the rest of Nairobi. It is expected that slums with higher 

roof coverage also have a higher population density and more constructions and less 

open space available. They have suggested that these areas are likely to also be more 

affected with matters to do with overcrowding problems of a severe nature such as 

shortage of basic needs, poor hygiene practices and easy prey to diseases. Slums with 

small roof area may have large unbuilt areas which could be put to productive use for 

social purposes or for farming or any other activity which may be beneficial to the 

poor residents of the slums. 



 

 

Figure 13 Roof Coverage w.r.t NDVI for Slum and Non-Slum Areas in Nairobi (QGIS) 

 

Land Feature Green Roof Area 

Count 

Green Roof Coverage 

% Area 

Colour Notation 

Slum Areas 162  8.3 Black 

Residential (non-slum) 855 47.9 Blue 

Table 10 Key Statistical metrics extracted for Slum and Non-Slum Areas in Nairobi 

This study was conducted in Rio de Janeiro and the estimated total coverage of the 

roofs for the slum areas differed as follows; 2. 8% to 83. 5 % of its human resources 

This show a wider variation than the one recorded in Nairobi. Such variable range is 

attributed to disparities in urban development and growth of various zones within city 

areas. Some favelas are formed by a set of buildings located closely packed with very 

little empty spaces between them while in others the houses are more spaced out with 

perhaps large areas of vegetation or other structures. 



 

 

Figure 14 Roof Coverage w.r.t NDVI for Slum and Non-Slum Areas in Rio (QGIS) 

 

Land Feature Green Roof Area 

Count 

Green Roof Coverage 

% Area 

Colour Notation 

Slum Areas 97  13.7 Black 

Residential (non-slum) 653 58.3 Blue 

Table 11 Key Statistical metrics extracted for Slum and Non-Slum Areas in Rio 

 

Higher maximum roof coverage in Rios’ slum as compared to Nairobi indicates that 

this in fact implies some areas in Rios are more congested and badly stretched in 

terms of infrastructure and overcrowd. Nevertheless, San Juan and Manila illustrate 

diverse slum roofs: the former has a higher proportion and better roof protection 

compared with the latter but is still characterized by substandard living conditions. 

5.5. Building Size Road Irregularity 

The analysis of building size and road irregularity in slum areas of Nairobi and Rio 

de Janeiro reveals common characteristics and these can be termed as typical of 

informal settlements.  



 

 

Figure 15 Building Sizes for Slum and Non-Slum Areas in Nairobi (QGIS) 

Land Feature Mean Median Colour Notation 

Slum Areas 66.2 44.5 Black 

Residential (non-slum) 92.8 54.2 Orange 

Table 12 Key Statistical metrics extracted for Slum and Non-Slum Areas in Nairobi 

The structures in both the city slum areas which are used for residential purposes are 

on an average of 40-60 square-meter floor area. 

 

Figure 16 Building Sizes for Slum and Non-Slum Areas in Rio (QGIS) 

Land Feature Mean Median Colour Notation 

Slum Areas 69.3 42.1 Blue 

Residential (non-slum) 229 125 Black 

Table 13 Key Statistical metrics extracted for Slum and Non-Slum Areas in Rio 



 

This is partly due to the small space and where most slum dwellers are subjected to 

poor economy hence their ability to build homes from scrap or poor-quality material 

which is easily accessible. 

5.6. Road Irregularity 

Another characteristic of slum areas is the disconnection of their road networks; they 

are fairly patchy. Thus, main roads in slum areas are narrow and curved and pave way 

for relatively random patterns unlike those found in more classy regions with more 

appropriately designed planned and systematic layouts of roads. In order to measure 

road irregularity, the coordinates of the vertices of the road lines were obtained by 

using GIS analysis tools.  

 

Figure 17 Road Nodal Network analysis with 1x 1 km grid for Slum and Non-Slum Areas in Nairobi 

(QGIS) 

Land Feature Mean Nodes per km^2 Mean Nodes per Road 

Slum Areas 225 37 

Non-Slum Areas 45 9 

Table 14 Key Statistical metrics extracted for Slum and Non-Slum Areas in Nairobi 

 

These were the vertices, which are the points through which roads junction or where 

the direction changes. Before the vertices were counted, they were divided by the 



 

total number of kilometers of roads in each of the slum areas. From this it is possible 

to obtain the nodes per kilometer which is a measure of the level of complexity and 

irregularity of the network. Research has it that the correlations of nodes per kilometer 

are higher for slum areas because it is a common thing for such neighborhoods to 

have evolved haphazardly.  

 

Figure 18 Road Nodal Network analysis with 1x 1 km grid for Slum and Non-Slum Areas in Rio 

(QGIS) 

Land Feature Mean Nodes per km^2 Mean Nodes per Road 

Slum Areas 127 25 

Non-Slum Areas 25 5 

Table 15 Key Statistical metrics extracted for Slum and Non-Slum Areas in Rio 

The high node density in slum areas also affects the accessibility of services and 

infrastructures since roads organization in slum areas may sometimes lead to the 

restriction of free movement of emergencies such as ambulances, garbage collection 

etc. This irregularity of navigating makes the separation process of those communities 

by depriving them of resource or service chances. Altogether, the small building sizes 

and irregular road patterns evidence the socio-economic problems and unorderly 

nature inherent to the slum areas of Nairobi and Rio de Janeiro. When aggregated and 

analyzed these characteristics give useful information on the spatial distribution of 



 

slum areas and thus the importance of designing urban interventions for enhancing 

living standards in these areas. 

6. Discussion and Challenges 

This thesis reveals the diverse nature of the physical environment of slums in 

Nairobi and Rio de Janeiro and shows that the structure of slum areas is diverse and 

unique, both in terms of potential for development and in terms of difficulties. The 

understanding of slope, socio-economic activities proximity, fractal dimension, 

roofed area, building area and road ruggedness helps in understanding spatial 

characteristics of slum areas for effective formulation of urban planning and 

policies. It further depicts the patterns and economic nature of slums of Nairobi and 

Rio de Janeiro to elucidate the issues and future of urbanization in the given areas. 

This means that the geographical setting of slums in Nairobi where many of them 

slopes and population density is high, which enhances the possibility for slippage 

as well as enhancing in fractional challenges. The general gradient of the slum 

regions of Nairobi is 10 percent. 19%, compared to 6. 39% in non-slum areas. 

Whereas, in Rio, the mean slope in slums is about 13. 8 percent, increasing exposure 

to the threats and responding to development propulsive endeavors. 

They provide that 83% of the slum areas, in Nairobi are within 500 meters of socio-

economic activities, which are economic zones for instance the industrial or the 

commercial zones. However, Rios slum areas are closer to such zones in only 20-

30% of the areas proving more tendency towards detachment from society. 

According to this analysis, fractal dimensions of Nairobi’s slum is higher than Rio’s 

slum that reveals decentralized and disordered urban growth pattern and 

challenging for city planning. 

Roof coverage data shows temporal fluctuation for both Cities: Nairobi roof slum 

area: 7% to 53%, and Sao Paulo’s favelas shows an even wider variety of numbers 

ranging between 2. 8% to 83. 5%. These values represent the density and pressure 



 

on the living conditions in specific areas of the United States, and therefore where 

a high roof coverage represents crowding and poor living conditions. Small building 

sizes such that most buildings range between 40-60 sq.m and fragmented road 

networks make service delivery even harder in both cities. 

Factors such as variation in resolution of images retrieved and subjectivity in the 

analysis of images also lead to error and uncertainties while identifying a slum. The 

future work would involve adopting better satellite data for the analysis together 

with better classification methods to increase the accuracies of the results. In details, 

therefore, the study calls for development specific urban planning strategies that fit 

the infrastructural, environmental and economic characteristics of slums in Nairobi 

and Rio de Janeiro. 

7. Conclusion 

The research aims to give an overall view on their geographical features as well as 

physical and socio-economic characteristics which define slum areas as informal 

settlements and differentiate them from the planned cities. The research reveals 

marked differences between slum and non-slum areas such as slope, distance to 

socio-economic activity, fractal dimension, and roof area density to provide 

indications of the spatial characteristics of these cities. Nairobi is a city 

characterized by steep slopes with slum areas developed on steep slopes which is 

unfortunately associated with high risks of landslides and great challenges in 

development. The closeness of the slums to socio-economic activities points to 

strategic, albeit risky, location in the flow of city’s economy. On the other hand, the 

remaining isolated slum zones in Rio are discussed in terms of completely different 

urban experience – social and spatial marginality keeps people poor and deprives 

them of contact with easier lifestyles. The fractal dimension analysis shows that 

slum formation is Decentralized, disordered and has a different pattern in both cities 

with higher slum complexity level in Nairobi due to factors such as urbanization 



 

pressure and population density. Roof coverage also shows the heterogeneity of 

slum density in the urban context, especially as it relates to the degree of 

development and population density in the slum areas. This pattern of residential 

buildings also shows the problem of accessing basic human needs such as proper 

housing and other essentials in slum areas; they are also informality that 

complicates the integration of the slum areas into the formal city. These attributes 

call for planning that takes into consideration the characteristics of slum areas and 

aims at the fair development of such areas. 

The study concludes that there is still a need to adopt methodological approaches to 

slum definition and Urban Development. Although, the individual assessments like 

slope or fractal dimension are informative; the complex relationship between these 

metrics provide enhanced comprehension required for accurate slum boundary 

definition and consequent application of corrective measures. Moreover, the 

comparison of Nairobi with Rio de Janeiro on these indicators shows that there is 

still a gap that has to be closed at the same time that proves that the approaches have 

to be contextualized. Local socio-geographical factors must be taken into account 

by urban planners and policymakers in the process of choosing strategies for slum 

upgrading and development. This kind of approach is crucial in the realization of 

Sustainable Development Goal 11. 1 which focuses on the strategies to promote 

adequate, safe and affordable shelter for all, especially for the people living in the 

informal sector. Summing it up, this study argues that apropos to the physical and 

socio – economic characteristics of slum territories can use geospatial histories, 

which this work has developed, as a useful map for understanding the regions 

applicability to the general questions of urban planning and policy making. 

Employing these findings, cities can work towards a more enhanced and appropriate 

technique on slum upgrading, which will therefore foster improved and improved 

urban development. 



 

Recommendations for Future Work 

1. Integrate socio-economic factors with spatial analysis to provide a holistic view 

of living conditions. 

2. Utilize high-resolution imagery and advanced algorithms to minimize errors in 

slum mapping. 

3. Explore temporal analyses to track slum growth and inform adaptive urban 

planning strategies. 
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9. Appendix 

Figure 19 DEM without pre-processing from SRTM 

 

 

 

Figure 20 Estimating the box-counting (Minkowski–Bouligand) dimension of the coast of Great Britain 
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Figure 21 Minkowski Dimension Calculator in QGIS Plugins Repository 

 

 

 


